
 Gta2 Editor Help Index

Commands
File menu
Edit menu
Tools menu
View menu
Window menu
Help menu



File menu commands

The File menu offers the following commands:

New Creates a new map.
Open Opens an existing map.
Close Closes an opened map.
Save Saves an opened map using the same file name.
Save As Saves an opened map to a specified file name.
Save 
Compresse
d

Saves and compresses the map.

Map Info Display Information about the current map.

Print Prints a map.
Print 
Preview

Displays the map on the screen as it would appear printed.

Print Setup Selects a printer and printer connection.
Exit Exits the editor.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Redo Reapply editing actions that have been undone.
Cut Deletes blocks from the map and moves it to the clipboard.
Copy Copies blocks from the map to the clipboard.
Paste Pastes blocks from the clipboard into the map.
Find Tile Finds the first occurance of a selected tile 
Find Next Tile Finds the next occurance of a selected tile
Replace Allows you to Replace tiles in a map
Objects Allows you to edit objects and select object options
Zones Allows you to edit zones and select zone options
Lights Allows you to edit Lights and select light options
Animations Allows you to edit Animations



View menu commands

The View menu offers the following commands:

Tile 
Selector

Shows or hides the Tile Selector

Block Info Shows or hides the Block Information Dialog bar
3D View the map in 3D.
Top View the map from Top Down (Overhead).
WORLD View the whole map (Overview).
Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Tools menu commands

The Tools menu offers the following commands:

Remove 
Hidden 
Faces

Remove all hidden faces from your map.

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Split Split the active window into panes.
Window 1, 
2, ...

Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help 
Topics

Offers you an index to topics on which you can get help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new map.

You can open an existing map with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing map. If you already have a map open you will be 
prompted to save this map if it has been changed and this map will be closed.

You can create new maps with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:
<< List your application's file types here. >>

Drives
Select the drive in which <<YourApp>> stores the file that you want to open. 

Directories
Select the directory in which <<YourApp>> stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active map.    You should save 
changes to your map before you close it.    If you close a map without saving, you lose all 
changes made since the last time you saved it.    Before closing an untitled map, the editor 
displays the Save As dialog box and suggests that you name and save the map.

You can also close a map by using the Close icon on the map's window, as shown below:



Save command (File menu)

Use this command to save the active map to its current name and directory.    When you 
save a map for the first time, the editor displays the Save As dialog box so you can name 
your map.    If you want to change the name and directory of an existing map before you 
save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active map. the editor displays the Save As dialog 
box so you can name your map.    

To save a map with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.



Save Compressed command (File menu)

Use this command to save and compress the active map. The editor displays the Save As 
dialog box so you can name your map.    

The map needs to be compressed in order to be run in the game. See Compression 



Map Info command (File menu)

Use this command to display information about your map.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
maps you closed.    Choose the number that corresponds with the map you want to open.



Exit command (File menu)

Use this command to end your Gta2 Editor session.    You can also use the Close command 
on the application Control menu.    Gta2 Editor prompts you to save documents with unsaved
changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo (Edit menu)

Use this command to reverse the last editing action, if possible. 

Shortcuts
Keys: CTRL+Z or

ALT-BACKSPACE

Note - Undo/Redo currently only works on Block Operations.



Redo command (Edit menu)

Use the Redo command to reapply editing actions that have been undone. Redo is unavailable 
unless you have used the Undo command.

Shortcuts
Keys: CTRL+Y or

Note - Undo/Redo currently only works on Block Operations.



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on 
the clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Find Tile (Edit menu)

Use this command to Find the first tile matching the index specified

See the Find Tile Dialog
See Find Next Tile
Shortcuts

Keys: CTRL+F



Find Next Tile (Edit menu)

Use this command to Find the next tile matching the index specified. Used after Find Tile 

See Find Tile
Shortcuts

Keys: CTRL+F



Goto command (Edit menu)

Use this command to move the camera above the x and y co-ordinates that you input.
These co-orates must be between 0 and 255.

Shortcuts
Keys: CTRL+G



Replace command (Edit menu)

Use this command to change a tile within the current map. This can be across the whole 
map or the selected area. You can specify a tile with only certain rotations, flips etc, and 
replace with a tile (or the same tile) with only certain rotations, flips etc.

See Replace Dialog for help on using the Replace dialog.



Object command (Edit menu)

Use this command to change map object options and edit routes

View View the map objects within the editor 
Edit    Edit the map objects within the editor
Add 



Objects View (Edit menu)

Use this command to View Objects

See also Adding Objects  



Objects Edit (Edit menu)

Use this command to Edit the attributes of existing Objects.

See the Edit Objects Dialog  Adding Objects   



Objects Add (Edit menu)

Use this command to Add a new Object    (UNIMPLEMENTED)
See also Adding Objects 



Zone command (Edit menu)

Use this command to change map object options and edit routes

View View the map Zones within the editor 
Edit    Edit the map Zones within the editor
Add Add the current selection as a zone



Zones View (Edit menu)

Use this command to View map Zones
See also Adding Zones  



Zones Edit (Edit menu)

Use this command to Edit existing Zones
See also Adding Zones  



Zones Add (Edit menu)

Use this command to Add a new Zone using the current selection as its position
See also Adding Zones  



Lights command (Edit menu)

Use this command to change Light options and edit Lights

View View the map Lights within the editor
Edit    Edit the map Lights within the editor
Add Selection Add a light at the current Top-left block of the currntly selected blocks.
View Markers View markers at the position the lights have been placed. 



Lights View (Edit menu)

Use this command to View Lights



Lights Edit (Edit menu)

Use this command to Edit Lights



Lights Add Selection(Edit menu)

Use this command to Add a Light at the top-left of the selected blocks



Lights View Markers (Edit menu)

Use this command to view markers where lights have been positioned in the map.



Animation command(Edit menu)

Use this command to setup animations for your map.



Tile Selector (View menu)

Use this command to show or hide the Tile Selector.

The tile selector Blah Blah Blah.



Block Info (View menu)

Use this command to show or hide the Block Information Dialog bar.

The Block Information Dialog bar Blah Blah Blah.



3D View command (View menu)

Use this command to view the current map in 3D.



Top Down View command (View menu)

Use this command to view the current map from Top Down (Overhead).



World View command (View menu)

Use this command to view the whole of the current map (Overview).



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in the Gta2 Editor, such as File Open.    A check mark appears next
to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in the Editor,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new map.

Open an existing map. The Gta2 Editor displays the Open dialog box, in
which you can locate and open the desired file.

Save the active map with its current name.    If you have not named the
map,the Gta2 Editor displays the Save As dialog box.

Compress and Save the active map.    The Gta2 
Editor displays the Save Compressed dialog box.

Remove selected data from the document and stores it on the 
clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Print the active document.





Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Editor's window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate the co-ordinates of the top-left block of the current 
selection :



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You
can open multiple document windows to display different parts or views of a document at 
the same time.    If you change the contents in one window, all other windows containing the 
same document reflect those changes.    When you open a new window, it becomes the 
active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



Split Command (Window menu)

Use this command to split the active window into panes.    You may then use the mouse or 
the keyboard arrows to move the splitter bars.    When you are finished, press the mouse 
button or enter to leave the splitter bars in their new location.    Pressing escape keeps the 
splitter bars in their original location.    << In a single document interface application, this 
command will appear on the View menu. >>



1, 2, ... command (Window menu)

<<YourApp>> displays a list of currently open document windows at the bottom of the 
Window menu.    A check mark appears in front of the document name of the active window.  
Choose a document from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using <<YourApp>> and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of the 
Gta2 Editor.



Context Help command 

Use the Context Help command to obtain help on some portion of the Gta2 Editor.    When 
you choose the Toolbar's Context Help button, the mouse pointer will change to an arrow 
and question mark.    Then click somewhere in the Gta2 Editor's window, such as another 
Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

<< Show your application's title bar here. >>

The title bar is located along the top of a window.    It contains the name of the application 
and current map (including the full path).

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button

Document Control-menu button

Maximize button

Minimize button

Name of the application

Name of the document

Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.

<< Describe the actions of the various parts of the scrollbar, according to how they behave 
in your application. >>



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the <<YourApp>> window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    <<YourApp>> 
determines which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    <<YourApp>> 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Editing your Map

There are various ways of editing your map depending on which view you are currently 
in .There are three different ways of viewing your map:

3D View (the default). See 3D View
Top Down View. See Top_Down View
World View. See World View



Autosave Features

The GBH Editor can automatically saves the map you are working on. 



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>



Remove Hidden Faces (Tools menu)

This will attempt to remove all the faces of all the blocks that cannot be seen in the game. 
This is automatically performed before compression is performed with the Save compressed.

NOTE. Because of the large amount of changes made to the map this menu option has NO 
undo feature.



Edit Lights Dialog

Use this Dialog to edit lights



Replace Dialog

Use this Dialog to replace tiles.



Find Tile Dialog

Use this Dialog to Find the first ocurrance of the tile specified.



Edit Object Dialog

Use this Dialog to to edit existing objects.



Rotate Selected Tile

Blah, Blah, Blah



Rotate Selected Tile

Blah, Blah, Blah



Rotate Selected Tile

Blah, Blah, Blah



Rotate Selected Tile

Blah, Blah, Blah





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>





ZONE DIALOG



The index of the current zone.
(Zones are stored in order of smallest first)



Lets you specify the type of the zone
See Zone Types.



Displays the current zone's name which you can edit.
Or you can cycle through the other zones of the same type



This will close the dialog and save any changes made.



The width of the zone (in blocks).



The height of the zone (in blocks).



The left coordinate of the zone (in blocks).



The top coordinate of the zone (in blocks).



Display only zones of the selected type.



Display the previous zone.



Delete the selected zone.



Create a new zone.



Display the next zone.



ANIMATION DIALOG



This displays the frames in the current animation.
The currently selected frame is highlited.



This displays the tiles which can be used for the frames in an animation.



The index of the currently selected frame in the current animation.



This is where the current animation is played.



Play the current animation
 or stop the current animation if already playing 
(NOTE the frame rate of the animation is only an estimate).



The index of the currently selected tile.



View the previous animation.



View the next animation.



Create a new animation.



Delete the current animation.



The current base of the animation.



The number of game frames that each frame of the animation is displayed for (NOTE the 
frame rate of the animation is only an estimate).



The number of times the animation will play for (0 will play forever).



The tile number of the currently selected frame of the animation



Add the currently selected tile to the animation.
Double clicking a tile will also add it.



Delete the currently selected frame of the animation.
Double clicking a frame of the animation will also delete it.



Set the currentl selected frame of the animation as the base frame.



HID_ANIMTILES_CANCEL.



HID_ANIMTILES_OK.



The number of frames in the current animation



TILE PICKER    DIALOGBAR



HIDC_DLGBAR_FLIP_X



HIDC_DLGBAR_FLIP_Y



HIDC_DLGBAR_ROT



HIDC_DLGBAR_GROUP



HIDC_BUTTON_FLIP_X





 Gta2 Map Editing Index

Commands
Overview 



Overview of a Gta2 Map

Gta2 Maps are made of buildings, zones, lights and objects.



Creating the Cityscape

The cities in Gta2 are made up of buildings, roads, pavements and fields. 



Adding Lights

While creating the cityscape you may add lights.



Adding Objects

While creating the cityscape you may add objects.

Map objects are items, such as bins, piles of rubbish & trees which can be positioned on top of any valid 
ground block in the map. An object cannot be placed where there is only air or water or on top of blocks 
without proper collision, such as diagonals.

Map zones consist of the following data :

The X and Y co-ordinate of the object in blocks.
The Rotation of the object (0 – 360 degrees).
The Type of the object.

No Z co-ordinate is specified, as the object is assumed to be sitting on top of the ground at whatever 
height that happens to be. For this reason objects can only be place when in the Top Down View.

To add an object in the World View, select Objects from the Tile Picker (when in top down view). This 
enables objects to be placed (as you would a tile) moved and deleted.

To Edit an existing Zone double click on the object with the left mouse button and modify one or more of 
the object’s field. See Editing Zones



Adding Animations

While creating the cityscape you may add animations.



Adding Zones

After creating the cityscape you must then divide the city up into map zones.
Map zones are used in the game to identify named areas for various purposes.
Map zones consist of the following data :

The X and Y co-ordinate of the top left corner of the zone (in block co-ordinates).
The Width and Height of the zone in blocks. Only rectangular zones are allowed.
The Name of the zone. Valid lengths are 1 to 255 characters.
The Type of the zone.

For a list of valid zone types see Map Zone Types:

Before adding zones make sure that you have set view zones to on using the menu item Edit-Zones-
View.

To add a zone in the 3D or Top-Down Views, select the blocks you want to craete as a zone and use the 
menu item Edit-Zones-Add Selection. You will then see the Edit Zone Data Dialog to fill in the rest of the
field required. see Editing Zones

To add a zone in the World View, right click in the view and and from the context menu select Add Zone. 
Then use the mouse to create a rectangle where the you want the zone to be. You will then see the Edit 
Zone Data Dialog to fill in the rest of the field required. see Editing Zones

To edit an existing zone see Editing Zones



Map Zone Types

General Purpose zones are used simply to mark an area so that it can be referred to by that name in 
mission scripts.

Navigation zones are used to store the correct geographical names of areas within the city. When the 
player enters a new navigation zone, its name is displayed on screen. When a police radio message 
reports a crime, the enclosing navigation zone is used to describe the area. Every block in the city must 
be within some navigation zone. They can overlap, in which case the smaller area zone gets priority. It is 
not allowed for equally sized zones to overlap. The navigation zone names are not translated in foreign 
versions of the game – they always have the same name. For large areas, the game appends North, 
South, etc. to the displayed name, so as to give the player a better idea of where he is.

Traffic light zones are used to mark junctions where traffic lights are required. The game will 
automatically construct a traffic light system at each traffic light zone. It is not allowed to place a traffic 
light zone on an area which is not a valid junction.
Traffic light zones must not be on slopes, and must not be within one block of the end of a slope. Traffic 
light zones must be at least a screen away from each other.

Railway Station zones are used to mark the location of railway stations The platform zone marks where 
the platform is, i.e. where peds should stand. This must be adjacent to a valid train route. The stop point 
marks where trains should stop. The entry and exit points mark the points on the track where trains    
enter and exit the station.

Bus Stop zones are used to mark the location of bus stops.    The zone is placed on the pavement and it 
marks where the peds should stand. Buses will stop at the nearest road piece( error if none close ). There
are no specific bus routes – buses are simply created at random and stop at bus stops whenever they 
pass them.

General Trigger zones are used to mark the position of general purpose triggers. These are used by 
mission scripts to set off an event when the player enters an area of the map. Normally, some sort of 
event will be associated with the general trigger zone in the mission script.

Information zones are used to mark an area which has different information values from the area round 
about it. The actual information is set up using the mission script.

Gang zones are used to mark the areas used by particular gangs. The name of the zone is the name of 
the gang. Any one gang may have many zones.

Local Navigation zones are used, like navigation zones, to mark the names of places which the player 
can visit. Local navigation zones will tend to be smaller than main navigation zones. On-screen, the local 
navigation zone is shown before the main navigation zone – e.g. “Johnny’s Strip Club, Hackenslash” 
would be displayed if the player is in the local navigation zone “Johnny’s Strip Club” and the main 
navigation zone “Hackenslash”. The rules for overlapping for local navigation zones are the same as for 
main navigation zones. However, unlike main navigation zones, local navigation zones do not have to 
cover the whole city.

Restart zones are the places where the player is restarted after he dies . There must be at least one 
restart zone in a map. They can be any size . When the player dies, he is restarted at the nearest restart 
zone ( except if it is a mult-player game and another player is too close ) .

Arrest Restart zones mark the places where the player is taken to after he has been arrested. They must
be only one block in size.

Named zones in the city need not have different names to each other. However, it should be noted that 
there could be confusion when a mission script refers to a zone by name if that name is not unique.





Editing map Zone

To edit an existing zone, use the menu item Edit-Zones-Edit.



Editing map Objects

To edit an existing zone, use the menu item Edit-Objects Edit.



Keyboard Commands

i - set mode to Eye Dropper
d  - set mode to Draw Tile
v  - set mode to select

r  - Set Mode to Rotate Tile
x  - Set Mode to Flip Tile X
y  - Set Mode to Flip Tile Y

 
Shift Del - Delete (Cut) Selected Blocks

Enter - select Block in centre of view

ctrl T - display/hide Tile Selector
ctrl B - display/hide Block Info

a/z - move Up/Down through blocks

Left Arrow - Scroll Left
Right Arrow - Scroll Right
Up Arrow - Scroll Up
Down Arrow - Scroll Down

Ctrl + Left Arrow - Move Selection Left
Ctrl + Right Arrow - Move Selection Right
Ctrl + Up Arrow - Move Selection Up
Ctrl + Down Arrow - Move Selection Down

Alt + Left Arrow - Move Selection Left (Including Blocks)
Alt + Right Arrow - Move Selection Right (Including Blocks)
Alt + Up Arrow - Move Selection Up (Including Blocks)
Alt + Down Arrow - Move Selection Down (Including Blocks)

Shift + Left Arrow - Increase Selection Left
Shift + Right Arrow - Increase Selection Right
Shift + Up Arrow - Increase Selection Up
Shift + Down Arrow - Increase Selection Down

Shift + Ctrl +Left Arrow - Decrease Selection Left
Shift + Ctrl +Right Arrow - Decrease Selection Right
Shift + Ctrl +Up Arrow - Decrease Selection Up
Shift + Ctrl +Down Arrow - Decrease Selection Down

KeyPad 5 - Draw all Lid Tiles selection (Num Lock Must be ON
KeyPad 8 - Draw all Top Tiles in selection " "
KeyPad 2 - Draw all Bottom Tiles in selection " "
KeyPad 4 - Draw all Left Tiles in selection " "
KeyPad 6 - Draw all Right Tiles in Selection " "
KeyPad 0 - Draw all Lids/Sides in Selection " "

Draw Mode
LButton - Draw Tile (under mouse pointer)
Shift + LButton - Draw All Lids in Selection
Ctrl + LButton - Draw All Lids/Sides in Selection



3D stuff

Key 1 View Textures
Key 2 View Block Types
Key 3 View Collision Info
Key 4 View Default Tiles (setup in Tools/Setting/Default Tiles)

Arrow Keys Same as was in 2D
ctrl + R Set Camera to Rotate
ctrl + D Set Camera to Dolly (in/out)
ctrl + E Set Camera to X/Y Axis Translate
ctrl + W Set Camera to Z axis Translate

LButton Select Block as Selection
Enter Select Centre Block as Selection

LButton and Mouse Move Select BlockS
RButton and Mouse Move Rotate/ Move Camera

Holding Shift/control/shift and control will change the Camera Mode

P Zoom Camera In
L Zoom Camera Out
Esc Move Camera to look Down on current Block




